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I.  Introduction 
The growing proliferation of mobile devices and the displaying of GIS data on the 
web have been changing the GIS industry.  The desire of organizations to collect 
GIS data using mobile devices and to display that data on the web is increasing 
rapidly.  The major reasons organizations want to move to this model is its ease of 
use, the ability for end-users to collect data, and the ability to easily distribute data 
to the world. 
 
My two main objectives with this paper were to explore the software and steps 
required for collecting GIS data with mobile devices (smartphones such as 
iPhone, Android, and Windows Mobile) and for displaying that collected data on 
the web.  I accomplished this by attempting to develop a mobile GIS collection 
and display solution using each of the options currently available for building 
mobile apps.   
 
The first part of the paper, application options, details my results of attempting to 
build a GIS data collection and display solution using each type of mobile app 
development option currently available.  For each option the possibilities for 
collecting data and displaying data are covered as are my mobile device test 
results.  The pros, cons, and potential applications of each option are also covered. 
 
The second part of the paper, detailed instructions, gives detailed step by step 
instructions on how to create GIS data collection and display solutions for each of 
the development options found to have the most potential.  Each set of detailed 
instructions covers all of the steps needed by a user with no previous experience 
to install, configure, build, and deploy the solution. 
 
The mobile devices I used for testing were the iPad 2 running iOS version 5.0.1 
and the Sony Tablet S running Android version 3.2.  I was unable to obtain 
Windows Mobile or Windows Phone 7 devices for testing. 

 
 
II.  Application Options 

This section covers all of the options currently available for building mobile apps.  
The options are broken into 4 main types: using pre-built mobile apps; building 
semi-custom mobile apps using WYSIWYG editors; building for Web Browsers 
and Google Maps/Earth; and building custom mobile apps from scratch.  I 
attempted to develop a mobile GIS collection and display solution using each 
option, reporting the results of each attempt below.  

 
1.  Use Pre-built Mobile Apps  

In the context of this paper pre-built apps is where a organization has already 
developed mobile apps and released them to the App Store/Market.  The main 
structure and functions of the app do not require any coding or modification.  The 
user only builds the forms, or sets up the maps that will be used inside of the app, 
for their particular project. 
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 a.  EpiCollect by Imperial College, London 
 

i.  About 
EpiCollect.net provides a web application for the generation of 
data collection forms and hosts project websites for viewing 
collected data for mobile data collection projects.  Data can be 
collected using the EpiCollect Mobile App on either the Android 
Operating system or iOS.  Collected data is uploaded from the 
mobile devices to a central server for viewing using a Google 
Maps based map interface which can be used on a PC based web 
browser or directly on mobile device browser.  EpiCollect is a free, 
open source project developed by the Imperial College of London.  
 

  ii.  Collect 
EpiCollect provides apps for iOS and Android.  The pre-built apps 
are supplied ready to go from the corresponding app stores and 
provide the basic structure.  The user creates a custom data 
collection form to fit their needs using a web based form builder, 
then the form is used to collect data inside the pre-built app.  The 
user collects the data to the local device then synchronizes the data 
out to their project space on the EpiCollect owned web based 
server.  
 

  iii.  Display 
The collected data can be accessed via a regular computer using 
the EpiCollect website which allows for viewing the data table, 
displaying the data on a Google Maps based web map, or 
downloading the data as a KML file.  The KML can be 
downloaded via a URL allowing for the file to be grabbed and 
converted to a shapefile using a Python script for use in ArcMap.  I 
tested this and was able to download the KML file and import the 
data into ArcMap using a Python script - which would allow for 
the creation of a simple button in ArcMap or a scheduled 
download.  Once in ArcMap the collected data could be published 
to a ArcGIS Server.  A script could also be used to download the 
KML file and post it to a website for viewing in Google Maps or 
Earth. 
 
The collected data can also be viewed on a map in the EpiCollect 
Mobile App.  The app allows the user to map only the data they 
have collected, the data others have collected, or both. 
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iv.  Test Results 
Android: 
The pre-built app downloaded and installed successfully on the 
Sony Tablet.  I was able to successfully collect data using a form I 
built with radio button questions, photo capture, and GPS location 
data capture.  Unfortunately once the data was collected to the 
local device, the data would not synchronize to the central server, 
giving a synchronization failed error.  The developer was contacted 
and they are looking into the issue.  The error may be caused 
because the app was developed for Android 2.x devices while I 
was using a 3.2 device.  
 
iOS: 
The app downloaded and installed successfully on an iPad 2.  I was 
able to collect data using the form I created and synchronize the 
data to the central server with no errors.  I was able to see the 
collected data inside the app on the mobile device and on the 
website via a PC.  One slight issue was that since the app was 
developed for the iPhone, the viewing area of the app was only a 
small area of the larger tablet screen.   
 

v.  Pros 
No server or app store space is needed.  The app and project 
website are free.  The app allows for offline data collection. Easy 
ArcMap integration is possible.  Collected data can be viewed in a 
map on the mobile device immediately.  Detailed instructions, with 
screen captures, on installing and using the app are available online 
for end users. 
 

vi.  Cons 
The Android app would not synchronize on my test device.  There 
is no technical support.  Three is no control over the app, website, 
or future changes.  The user must rely on a app and server that is 
not under their control and thus may be discontinued.  The apps are 
not tablet friendly.  Only point data collection is possible. 
 

vii.  Potential Applications 
The EpiCollect system would work best for simple projects where 
basic data collection is desired., projects where no central servers 
can be owned, projects where support for iOS and Android is 
needed, and projects where cost is an issue, such as with 
nonprofits.  It would also be a good option for users with limited 
technical knowledge. 
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b.  Open Data Kit by the University of Washington Computer Science Dept 
 

i.  About 
Open Data Kit (ODK) is a free, open-source set of tools which 
allow users to author, field, and manage mobile data collection 
solutions. ODK provides an out-of-the-box solution for users to: 
Build a data collection form or survey; Collect the data on a mobile 
device and send it to a server; and Aggregate the collected data on 
a server and extract it in useful formats.  ODK is funded by a 
Google Focused Research Award.  The ODK system is for 
Android only. 
 

 ii.  Collect 
ODK supplies a pre-built Android app through the Google App 
Market which provides the basic structure.  ODK also supplies a 
web based form builder to build forms for use inside the ODK app 
and an application, using Google App Engine, for storing and 
publishing of user created forms.  The Google App Engine app 
also acts as a database type system for centralized storing of the 
collected data.  An instance of the database type system is created 
in a users own Google App Engine account space allowing for 
complete ownership and control of the system. 
 
To create a form the user builds the form using ODKs web based 
form builder.  The ODK form builder allows for sophisticated 
forms to be built that can include text boxes, uploading media 
(image, audio, video), radio button selections, and GPS location 
recording using a simple interface.  The forms can also include 
branches allowing different items to be displayed based on input (a 
different set of fields shown based on a Yes answer versus a No 
answer on a form question for example).  The user built form is 
uploaded to the users database instance in their Google App 
Engine space, allowing any internet connected user to download 
and use the form (authentication options are available). 
 
To collect data end users first download the ODK app from the 
Google App Market then connect to their private Google App 
Engine database instance to download the custom form.  Once the 
custom form is downloaded it can be used as many times as 
desired with each use saved to the mobile device as a separate 
submission.  The submissions can then synchronized up to the 
private App Engine database when complete and the device is 
connected.  This storing to the local device for batch 
synchronization allows for offline data collection. 
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iii.  Display 
The ODK database type application, called Aggregate, is accessed  
via a web browser interface, using a regular PC or a mobile device, 
at the users private Google App Engine space.  The submitted data 
is grouped by the form that was used to create it.  The submissions 
can be viewed in a web browser as a text list, downloaded to a 
CSV file, sent to a external service (such as Google Spreadsheet, 
Rhiza Insight, or Google FusionTables - with more options 
coming), or downloaded as a KML file.  The CSV or KML file 
could then be imported to ArcMap or the KML could be mapped in 
Google Earth or Google Maps.   
 
Viewing the collected data on a map from a mobile device could 
be accomplished in a number of ways.  One is to download the 
KML file and post it to a website as a Google Maps connected 
URL link, which would work well for the posting of files daily.  
Another way is to connect ODK Aggregate to a Google Fusion 
table, which allows for uploading of collected data and streaming 
of new data as it arrives.  The Fusion table can be mapped inside 
the Fusion interface on a regular computer or on a mobile device.  
Also a URL can be created that opens a Google Map linked to the 
Fusion Table.  This method allows for live time updates, showing 
newly collected data on the Google Map with each refresh. 
 

iv.  Pros 
A major plus for ODK is that the App, form builder, aggregate 
server, and Google App Engine space are all free.  Plus the project 
is open source, so the source code can be obtained and edited.  
Another major plus is that ODK provides a complete solution, 
from form building to an online database.  Offline data collection 
is supported.  Sophisticated forms can be built with branching and 
media.  Many download formats are supported.  There is tight 
integration with Google products and security.  Using the Google 
App Engine servers provides the user with a worldwide, fast, 
redundant database.  The product suite is easy to use and deploy.  
The product is actively being developed as part of a Google 
research grant.  The collected data can be displayed almost live 
time on a Google Map.  The tools can be password protected using 
Google accounts.  
 

v.  Cons 
The solution with work for Android devices only with no plans to 
add iOS.  There is no dedicated support available.  Only point data 
collection is possible. 
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vi.  Potential Applications 
ODK would only work for projects where the device to be used is 
known to be Android.  ODK is especially suited to projects where 
the data collection is form or question based.  Since all of the 
pieces of ODK are free to use, and no server or other equipment is 
needed, non-profits that require a low cost solution would be a 
good fit.   

 
 c.  ArcGIS Mobile Solutions by Esri 
 
  i. About 

Esri is currently the market leader in GIS desktop software.  
Typically their products, such as ArcMap, are closed source and 
must be purchased.  Esri has developed several mobile solutions 
including ArcMobile for use with Windows Mobile devices, 
ArcPad for use with Windows devices, an app for Windows 7 
Phone, an iOS app for iPhone/iPad devices, and very recently an 
app for Android devices.  The iOS, Android, and Windows 7 
Phone apps are free but require a ArcGIS Server to host maps and 
store collected data.  Note that ArcPad is not covered in this paper. 
 

  ii. Collect 
   ArcMobile for Windows Mobile 5.0 to 6.5: 

Applications for Windows Mobile devices are created using 
ArcMobile, a separate program sold by Esri.  ArcMobile includes 
the Mobile Project Center which is used to build a map based 
application by selecting what layers are available on the map from 
ArcGIS Server published resources and base maps.  The Mobile 
Project builder also configures which tasks are available such as 
View Map, Collect Features, Search, View Work List, and Manage 
Edits.  The project is then published to a ArcGIS server for 
download to the mobile device, installed using push technology, or 
copied directly to the device.  The app is not form based but map 
based with a few tasks that can be configured.  Data collection 
involves collecting point, polyline, or polygon geometry.  Editing 
attributes of existing map features is also supported.  Geometry can 
be created using the map, using the average GPS position of the 
device, or streaming the GPS position.  The attributes of the 
features collected can be entered once the feature is created.  Edits 
are collected to the local device then synchronized to a ArcGIS 
Server when connected to a network. 
 
Esri pre-built App for Android: 
The Esri made app for Android was just released the last week of 
October 2011 during the writing of this paper.  The app is a free 
download available at the Android App Market.  The app provides 
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a mobile friendly structure around web based map content.  The 
app can display content hosted at ArcGIS Online or content hosted 
on a private ArcGIS server, along with Esri provided basemaps.  
Existing features can be edited or new features can be created on 
the map with or without device GPS integration.  Since the app 
uses web based content, offline collection is currently not 
supported, but there are plans to implement offline data collection 
and offline map viewing in Q2 of 2012.  Note that ArcMobile is 
not needed.   
 
Esri pre-built App for iOS: 
The Esri made app for iOS (iPhones/iPads) is almost identical to 
the Android app.  The app is a free download available at the 
Apple App Store.  The app provides a mobile friendly structure 
around web based map content.  The app can display content 
hosted at ArcGIS Online or content hosted on a private ArcGIS 
server.  Existing features can be edited or new features can be 
created on the map with or without device GPS integration.  The 
iOS app is more polished than the Android app with a better legend 
display, easier to understand interface, and better editing interface.  
This difference is probably attributed to the fact that the iOS App 
is currently in version 2.1 while the new Android App is at version 
1.0.  Since the app uses web based content offline collection is 
currently not supported, but there are plans to implement offline 
data collection and offline map viewing in Q2 of 2012.  Note that 
ArcMobile is not needed.   
 
Windows 7 Phone: 
The Windows 7 Phone app works like the iOS and Android apps, 
providing a mobile friendly interface wrapper around web based 
ArcGIS Server maps.  It is completely different and separate from 
the Windows Mobile product.  I was unable to obtain a Windows 7 
Phone device for testing so this product is not covered. 
 

iii.  Display 
On a regular computer published maps, along with any collected 
data, can be viewed in a web browser using a ArcGIS Server Web 
Application, at ArcGIS Online, within ArcMap, or using Google 
Maps by creating KML files.   
 
On a iOS or Android Mobile device published maps, along with 
any collected data, can be viewed using the Esri built apps or 
through the mobile device web browser using a ArcGIS Server 
Web App.  In a mobile device browser all of the features work but 
can be difficult to use as the small buttons were not designed to be 
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used on a mobile device.  Also editing is difficult as the Web app 
assumes a mouse is used instead of taps.   
 
The iOS and Android mobile apps basically provide a Mobile 
device friendly interface wrapper around ArcGIS Server web based 
maps using REST.  In the Mobile Apps maps can be distributed by 
publishing to ArcGIS Online and then using My Maps in the app, 
or hosted on a private ArcGIS Server by setting up a map item in 
the Mobile Content Directory then connecting via a URL in the 
ArcGIS Servers section of the apps.  Since the apps pull content 
from the Web, the Mobile device must be connected to a network 
for any map browsing (note offline map browsing is planned as a 
feature in 2012).  Since the maps are always pulled from the web, 
edits are seen by all users instantly upon map refresh. 
 

iv.  Test Results 
 Window Mobile (tested on emulator only): 

ArcMobile comes with a Windows based emulator for testing the 
mobile projects built.  All functions worked flawlessly in the 
emulator.  I was able to view the maps, collect line and polygon 
data, upload the data to the server, and view the updates via a web 
browser with no issues.   
 
The major difference between the Windows Mobile and 
iOS/Android Apps are the offline capabilities.  A .wmpk install file 
is created and installed locally, along with the data, on the 
Windows Mobile device as a regular Windows file would be.  
Edits are done at the local level and then manually synchronized 
back to the server.  The product installation process and the app 
development process was very easy to understand and better 
documented then the iOS or Android Apps.  The app itself was 
more polished as well, probably due to its longer time on the 
market.  Unfortunately, however, Windows Mobile devices are not 
very popular and I was unable to find a physical Windows Mobile 
device to test on.  See the detailed instructions section of this paper 
for more information and detailed setup instructions. 
 
Windows 7 Phone: 
I was unable to obtain a Windows 7 Phone device for testing so 
this product is not covered. 
 
Android (tested on a Sony Tablet S with Android v3.2):   
Using a Web Browser on Android: 
One option tested is to skip using the mobile app and view a 
regular ArcGIS Web Application in the Android web browser.  
Most functions did work but were difficult to use since the various 
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buttons and check boxes were not designed for a mobile device 
and are too small to use easily via a touch interface.  This was 
especially an issue for the Pan tool.  Any finger swipe caused a pan 
on the tablet itself, not on the map.  The editor feature did work 
and I was able to collect lines or polygons, but due to the touch 
interface of Mobile devices it was difficult to get exact feature 
placement.  Click and drag operations are not possible as with a 
mouse, all operations required a tap.  Selecting a feature and 
editing the attributes was easier, and I was able to successfully 
change attributes in the editor and post the changes to the server. 
 
The built-in Android browser and the new Firefox browser were 
both tested.  The only major difference found was that in Firefox 
was that the finger must be held down for a second or two in order 
for the tap to register, a quick tap was not noticed by the browser.  
  
A major disadvantage to using a web browser based map is the 
lack of mobile device hardware integration to access the mobile 
device GPS or camera. 
 
Esri App from the Android App Market: 
As discussed above, the Esri Android App provides a mobile 
friendly interface to access web based maps hosted at ArcGIS 
Online or on a ArcGIS Server.  Maps are created on the ArcGIS 
Server by creating short JSON scripts which list what layers should 
be included in the map.  Since the app was designed for mobile 
devices, the problems discussed above related to using a web 
browser are eliminated.  Zooming and panning take advantage of 
the mobile devices touch screen interface allowing use of the 
pinching motion to zoom out and touch and drag for panning, 
similar to Google Maps (except that map rotation is not supported).  
The number of buttons is reduced to Measure Distance, Show GPS 
location, Map Query, and Edit.  GPS integration is included 
allowing users see their current location on the map and use their 
location to assist in editing (for example creating a point at their 
current location or starting a line from their current location).   
 
The Android App preformed fairly well, but not perfect, in tests.  
Map usage was intuitive and responsive once the map loaded but 
occasionally the base map would appear but not a layer, or the app 
would crash.  The only major issue seemed to be in editing.  
Editable layers took much longer to load and sometimes would not 
appear at all.  When creating features the created features would 
not appear on the screen but were created.  The interface was not 
as polished an the iOS app, which is common when comparing 
Android and iOS apps.  These issues are most likely related to the 
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app being released just a few days before I did my testing and will 
hopefully be fixed.  See the detailed instructions section of this 
paper for more information and detailed setup instructions. 
 
iOS (tested on a iPad 2): 
Using a Web Browser on iPad: 
One option tested is to skip using the mobile app and view a 
regular ArcGIS Web Application in the Safari web browser.  Most 
functions did work but were difficult to use since the various 
buttons and check boxes were not designed for a mobile device 
and are too small to use easily via a touch interface.  This was 
especially an issue for the Pan tool.  Any finger swipe caused a pan 
on the tablet itself not inside the map.  The editor would run and I 
was able collect lines or polygons, but due to the touch interface of 
mobile devices it was difficult to get exact placement.  Click and 
drag operations are not possible as with a mouse, all operations 
required a tap.  Selecting a feature and editing the attributes was 
easier, and I could change the attributes in the editor and the edits 
were posted to the server. 
 
A major disadvantage to using a web browser based map is the 
lack of mobile device hardware integration to access the mobile 
device GPS or camera. 
 
Esri App from the Apple App Store: 
The Esri iOS App provides a Mobile friendly interface to access 
web based maps.  The app is almost identical to the Android App.  
Users can access maps from their ArcGIS Online account using the 
My Content button or access maps by connecting to a ArcGIS 
Server.  Maps are created on the ArcGIS Server by creating short 
JSON scripts which list what layers should be included in the map.  
Since the app was designed for mobile devices the problems 
discussed above related to using a web browser are eliminated.  
Zooming and panning take advantage of the touch screen interface 
allowing use of the pinching motion to zoom out and touch and 
drag for panning, similar to Google Maps (except that map rotation 
is not allowed).  The number of buttons is reduced to Measure 
Distance, Measure Area (iOS only), Show GPS location, Map 
Query of the base layer, and Edit.  GPS integration is included 
allowing users to see their current location on the map and use 
their location to assist in editing (for example creating a point at 
their current location or starting a line from their current location).   
 
The iOS App preformed well in tests.  Map usage was intuitive and 
responsive once the map loaded.  Occasionally the app would 
crash while loading a map but this was rare.   
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The iOS App was more polished then the Android App, probably 
because it has been in development longer.  The iOS App had a 
Measure Area tool and Legend side bar that the Android App did 
not.  Editing worked without issue and I was able to tap a feature 
for a list of attributes, which did not work in the Android App.  See 
the detailed instructions section of this paper for more information 
and detailed setup instructions. 
 

v.  Pros 
The Esri products have the best mapping capabilities of any 
product tested and would be the best choice for any map intensive 
application.  All of the Esri Mobile products easily integrate with 
existing ArcGIS server installations allowing for quick and simple 
deployment of existing ArcGIS maps and data layers.  Esri is the 
only solution I found that supports the three major mobile device 
types on the market.  Ongoing development is very active with a 
large team at Esri working on Mobile solutions.  Esri is unique in 
that they supply pre-built Apps that are ready to use and supply 
APIs allowing users to build their own custom apps. 
 

vi.  Cons 
The tight integration with ArcGIS Server could also be considered 
a disadvantage if a organization does not have already have a 
ArcGIS Server installation.  The costs are high and the installation 
process complicated.  In order to enable editing of features the data 
must be stored in a SQL database and ArcSDE software must be 
purchased and used as a backend connection.  SQL software such 
as Microsoft SQL Express and PostgreSQL can be obtained for 
free, but do require a fair amount of expertise to be installed and 
configured properly.  
 
The Android and iOS apps must be connected to a network in 
order to view maps or collect data, which could be an issue when 
in remote areas with slow, or no, network access.  Offline access 
may be addressed in 2012 however.   
 
Users unfamiliar with ArcGIS Server Web Applications may find 
the interface confusing compared to Google Maps.  Sophisticated 
forms for data collection are not available as adding of data is 
limited to a list of attribute fields.   
 

vii.  Potential Applications: 
An Esri implementation would be best for map intensive 
applications, making existing ArcGIS Server applications available 
to mobile devices, or where support for multiple device types is 
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needed.  An Esri implementation would also work well for projects 
where custom apps, or integration with existing apps, is needed 
since APIs are provided by Esri for Java and Object C. 
 

Side Note - Using REST:  
If a user does have an existing ArcGIS Server the maps and layers 
hosted there can be used through REST calls in products such as 
Adobe Flex.  One example of this is the app GeoMobile by 
GeolocationSolutions.  This app displays map layers via a set of 
REST calls, which are setup with a JSON script in a configuration 
file.  It includes geocoder, draw, query, and route tools.  This app 
was tested successfully on both Android and iOS. 

 
 
2.  Build Semi-Custom Mobile Apps using WYSIWYG editors 

There are several companies, including Yapper, appmakr, and iBuildApp, that 
offer simple web based WYSIWYG editors for creating mobile apps.  These 
editors allow for the building of very basic apps by combining together a set 
number of pre-built buttons.   
 
The buttons are designed to bring together web content the user already has into 
one place with a mobile friendly front end.  Buttons usually include Home which 
links to the users home page, calendar which links to a users Google Calendar, 
Pics which links to Google Photos or uploaded image files, Contact which links to 
a phone number, Twitter which links to a users existing Twitter account, 
Facebook which links to a users existing Facebook account, and Map which links 
to a map of the users business location among a few others depending on the 
company used.  Most of these editors have the ability to publish the app built to 
both major platforms, Android and iOS, at the same time.   

  
Since the apps that can be built with these tools simply use existing web content, I 
did not find a potential for use in building GIS data collection applications.  Thus 
this way to build apps was not explored further. 

 
 
3.  Build for Web Browsers and Google Maps/Earth 

Recently there have been several products emerging that skip making mobile apps 
for each of the multiple platforms all together by developing web browser 
compliant applications instead.  These products create completely web browser 
based applications that are HTML 5 compliant and often use JavaScript.  The 
main drawback to this approach for GIS data collection applications is the 
inability for web browser based applications to access the hardware of the mobile 
device, such as the camera and GPS.  The main advantage is that the application 
should work on all mobile device types, including the less popular Palm and 
Blackberry.  Example companies making HTML 5 compatible apps include 
Sencha, PhoneGap, and Cabana. 
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Included in this section is a discussion on using Google Maps and Google Earth to 
display collected GIS data.  Since Google Maps and Google Earth have products 
that run on regular computers and all of the major types of mobile devices a 
solution developed for Google Maps/Earth should work across multiple platforms.    
  
a.  Collect 

If a user already has a web based data collection application, adjusting it to 
run on a mobile device may be a good option.  The major drawback to this 
option though is the lack of ability to access the mobile device hardware, 
mainly the GPS and camera.  There are a few products emerging that 
facilitate access to the mobile device hardware, but for now they are 
complicated and usually must be tailored to work for each type of device 
platform, defeating the purpose of attempting to develop a cross platform 
product.  If a user has a web based data collection product already built, a 
mobile app wrapper around the web pages to gain access to the mobile 
device hardware may be a good option.  The application would no longer 
be cross platform compliant however. 

 
b.  Display 

There are several web browser based mapping applications available that 
could be used to display GIS data.  A number of products were tested as 
discussed below, but only Google Maps and Google Earth are covered in 
detail for this paper. 
 
Since Google Maps and Google Earth have products that run on regular 
computers and all of the major types of mobile devices, creating a 
application that uses Maps or Earth could be considered cross platform.  
To use Maps and Earth for display the GIS data is converted to a KML 
file, then the KML file is distributed to the users via email or by posting 
the KML to a website.   

 
c.  Test Results 

Android: 
Without a custom web browser based app of my own to test, I instead 
tested several browser based mapping applications found online.  Pure 
display apps such as OpenStreetMaps worked well, as did several other 
sample adds found at OpenGeo.  Apps that use location data such as 
FishFinder, found through the Sencha demos section, would not display in 
the web browser at all so I was unable to test.   
 
As discussed in the ESRI section above a ArcGIS Server Web Service was 
fully functional when viewed within the built in Android web browser and 
FireFox web browser, but was difficult to use since it was not developed 
for a touch interface.  Also the ArcGIS Server Web maps have no 
integration with the mobile device GPS or camera. 
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Since Google Maps and Google Earth had the greatest promise for full 
cross platform compatibility I tested them extensively.  Both Google Maps 
and Earth have full access to the GPS location of the mobile device and 
therefore can show the user their current location and track them as they 
move.  Google Maps has the ability to route the user to any location on the 
map using the GPS with full turn by turn directions given in text, or even 
voice.  The maps cache the area near the user allowing the routing to work 
even after the device loses an internet connection (I did not find an exact 
limit to the cached map but I was able to still view a map for several miles 
after losing the internet connection).  Note that just before completion of 
this paper Google Maps version 6 was released with a new feature 
allowing users to download map caches covering the 10 miles around an 
area of interest. 
 
For GIS applications collected data is mapped by using custom KML 
layers in Google Maps.  Points, polylines, and polygons can all be 
displayed with full routing capabilities.  Being able to display user 
generated data in conjunction with all of the Google Maps data, from 
restaurants to bus lines to satellite imagery, and being able to get 
directions between any of these points, allows for some powerful 
applications to be built simply and cheaply.  The KML files can be 
distributed by posting them on a website or saving them to "My Maps" 
within Google Maps.  Unfortunately a major limitation with Google Maps 
is the limit of 1,000 features in any one loaded KML file, which could be a 
issue for some applications.  Google Earth has no limit but at this time 
Google Earth for Android can not display user loaded KML files as it can 
on a regular PC.   Other issues were discovered with the way KML files 
are handled on a PC browser versus on a mobile device which are 
discussed in the detailed instructions section. 
 
iOS: 
Without a custom app of my own to test I instead tested several web based 
mapping applications found online.  Pure display apps such as 
OpenStreetMaps worked well as did several other sample adds found at 
OpenGeo.  Apps that use location data such as FishFinder, found through 
the Sencha demos section, did work on iOS where they did not on 
Android.  
 
As discussed in the ESRI section above a ArcGIS Server Web Service was 
fully functional when viewed in the Safari web browser but was 
occasionally difficult to use since it was not developed for a touch 
interface.  Also the ArcGIS Server Web maps have no integration with the 
Mobile device GPS or camera. 
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Since Google Maps and Google Earth had the greatest promise for full 
cross platform compatibility I tested them extensively.  Both Google Maps 
and Earth have full access to the GPS location of the Mobile device and 
therefore can show the user their current location and track them as they 
move.  Google Maps has the ability to route the user to any location on the 
map using the GPS with full turn by turn directions given in text, or even 
voice.  The maps cache the area near the user allowing the routing to work 
even after the device loses an internet connection (I did not find an exact 
limit to the cached map but I was able to still view a map for several miles 
after losing the internet connection).  Note that just before completion of 
this paper Google Maps version 6 was released with a new feature 
allowing users to download map caches covering the 10 miles around an 
area of interest. 
 
For GIS applications collected data is mapped by using custom KML 
layers in Google Maps.  Points, polylines, and polygons can all be 
displayed with full routing capabilities.  Being able to display user 
generated data in conjunction with all of the Google Maps data, from 
restaurants to bus lines to satellite imagery, and being able to get 
directions between any of these points, allows for some powerful 
applications to be built simply and cheaply.  KML files can be distributed 
by posting them on a website or saving them to "My Maps" in Google 
Maps.  Unfortunately a major limitation with Google Maps is the limit of 
1,000 features in any one loaded KML file, which could be a issue for 
some applications.  Google Earth has no limit, and unlike the Android app, 
Google Earth for iOS can load KML files in by connection to files stored 
in My Maps (note My Maps has a limit to the size in MB of KML files so 
for large files convert to a KMZ, which is a compressed KML).   Other 
issues were discovered with the way KML files are handled on a PC 
browser versus on a mobile device, and some differences between Google 
Maps on iOS and Android were found.  These inconsistencies are 
discussed in the detailed instructions section. 
 

d.  Pros 
The major advantage to a web browser and Google Maps/Earth based 
approach is that the application should run on any mobile device platform 
with a browser or any other device that has a HTML compliant browser.  
Also no major adjustments should be needed for new devices or after 
software updates.  User training should be minimal as most users are 
familiar with the now near universal Google Maps and Earth interfaces.  
Using Google Maps/Earth also provides full map routing and access to 
Google's many built in layers, from aerial imagery to restaurants, with no 
developer action required.  Existing web browser based application can be 
used with potentially minor adjustments.  
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e.  Cons 
The major disadvantage to a web browser based approach is the lack of 
access to the mobile device hardware, mainly the GPS and camera.  While 
there are some workarounds to access the hardware available, they usually 
require special coding for each device type to run properly, making the 
app not truly cross platform.  The other major limitation is that since the 
app is web based, offline use may not be possible and network speed may 
be an issue.  The new map download feature in Google Maps 6 coupled 
with storing of the KML on the device may eliminate this issue however.  
If the user does not already have a web browser based application, one 
will need to be built from the ground up.  This could be difficult as 
building a mobile friendly browser based app can be much harder to build 
then for a regular computer.  Finally, even though Google Maps and 
Google Earth are available for almost every platform on the market, 
during testing custom KML files were found to work differently when 
used on different devices. 
 

f.  Potential Applications 
A web browser or Google Maps/Earth approach would be a good choice 
for applications where cross platform capability is critical, such as 
distributing data to the public.  It would also be a good choice for 
applications where the GPS location of the device is not needed, such as 
using a postal address as the location instead.  An application that requires 
routing, or has a limited budget would also be a good fit. 

 
 
4.  Build Custom Mobile Apps from Scratch 

The most custom solution is to program the code for the mobile app from the 
ground up.  For Android this means writing Java code and for iOS this means 
writing Object-C code.  This is "hard core programming", writing many lines of 
text based code, usually in a development environment program to help with 
syntax and testing.  This process can be tedious, especially when creating visual 
based forms.  While the vast majority of mobile apps are written this way, 
recently products have been emerging, such as Google App Inventor, that attempt 
to make the process easier and more visual.   
 
a.  Android (Java) 

This section of the paper is handled differently.  Instead of attempting to 
build a fully functioning data collection and data display app I 
documented the steps required in order to setup the entire environment 
needed to build a start base app.  This process was much more difficult 
then I thought it would be, even for someone with some programming 
background.  Several products and plug-ins must be installed and 
configured in just the right way in order to successfully write, compile, 
and run even the simplest Android Java app.  The steps required were 
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found and tested by building a working map display app started from 
sample code provided as part of the Esri Android API.   
 
The most popular Java Integrated Development Environment (IDE) is 
Eclipse, a free, open source project originally created by IBM.  The main 
steps needed to setup a computer in order to compile a Android app 
include: downloading and installing Eclipse; downloading and installing a 
Java Compiler; downloading and installing the Android SDK (plus 
extras); and downloading and installing the Android ADT plugin for 
Eclipse.  Then in order to use the Esri Android API to build the sample 
app discussed above, the ArcGIS API for Android Eclipse Plugin must be 
downloaded and installed.  Note that all of these products are free and 
open source.   
 
The process if fairly long and includes picking the right versions to install, 
and making sure settings are correct, in order for all of the pieces to fit 
together properly.  Once the Android app is compiled into a .apk file it can 
be tested in an Android device emulator on a PC, copied directly to a 
Android device using USB or a flash card, sent to the device using email, 
or posted on a website where the Android device can download it.  The 
steps required are all covered in the detailed instructions section. 

 
 b.  Google App Inventor 

In an attempt to make the app development process more visual and less 
text based coding, Google and MIT partnered on a project called Google 
App Inventor.  App Inventor uses a web based visual interface for 
developing the forms and the underlying code.  The project was started 
and designed as a way for non-programmers to build apps.  The project is 
still in Beta and thus has some limitations, but I believe it is the wave of 
the future for building Android apps.  I was able to create a simple app and 
run it on a Android device much easier then with Eclipse.  Detailed steps 
are not covered here since the process will soon be completely changed.  
The current Google App Inventor is being discontinued at the end of 2011 
to be replaced by the new MIT produced version in early 2012.  I expect 
the new MIT version to become a major app development tool going 
forward.  For more information on the MIT version 
see http://appinventoredu.mit.edu/.  For more on the current Google 
version see http://www.appinventorbeta.com/about/. 

 
 c.  iOS (Object-C) 

In order to build iOS apps a regular Mac computer is required, which I 
was unable to obtain access to for this paper.  Also note that while the 
XCode programming environment is free to members of the iOS 
Developer Program, the program itself costs $99 a year.  A few products 
are available that allow for building iOS apps on a PC but they are mainly 
designed to build game apps or build the apps in HTM\Javascript, which is 

http://appinventoredu.mit.edu/�
http://www.appinventorbeta.com/about/�
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covered in section 3 above.  There are some products coming to market 
now that allow code to be written in another language and then compiled 
into a format that will run on iOS, such as Servoy.  Since I was not able to 
obtain a Mac, or access to other software, the building of iOS apps from 
scratch is not covered in this paper. 

 
 
III.  Detailed Instructions 
 
1.  EpiCollect Detailed Instructions 

The EpiCollect website contains excellent step by step instructions, including 
screen shots, for setting up a project, installing and using the apps, and using the 
collected data.  Thus I will cover the main points only, referring to the website 
pages that contain detailed instructions.  I have also included a Python script that 
can be used to download the collected data and  convert it for display in ArcMap. 

 
The Overview Section of the EpiCollect website shows the main steps: 
 Create a Project Website  

Design a form 
Load the Epi Mobile App from the Android Market or Apple App Store 
Create a Form for the project 
Load the form created into the EpiCollect app 
Collect Data 
View Data collected at the EpiCollect Project website or in the app 
 

 (The steps are covered in detail at http://www.epicollect.net/instructions/.) 
 
Notes: 
As mentioned in the outline section, as of the writing of this paper the Android 
App would not synchronize data with the database server.  I contacted EpiCollect 
and they are looking into the problem.  It could be related to using the new 
Android version 3.2 since the app was originally developed for version 2.x 
devices.   
 
When building a form photo capabilities and GPS collection capabilities are 
included automatically.  What is added by the users are fields for any other data 
they would like to collect.  

 
ArcMap Integration: 
One of the great features of the EpiCollect project site is that the collected data 
can be downloaded as a KML file for display in Google Earth.  Since the KML 
download is done via a URL link I was able to write a simple Python script that 
downloads the KML and converts it to a ArcMap geodatabase with associated .lyr 
file.  This Python script can be used as part of a ArcMap Toolbox, ArcMap 
button, or scheduled to run on a regular basis, greatly simplifying ArcMap 
integration. 

http://www.epicollect.net/instructions/�
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# --------------------------------------------------------------------------- 
# Doug Browning  
# GetEPICollectKMLAddtoArcMap.py 
# For project with EPI 
# This program grabs the KML file from EPICollect then creates a layer from the 
KML for ArcMap 
# It stores the data in a geodatabase 
# Script is for ArcGIS 10 
# --------------------------------------------------------------------------- 
 
import  arcpy, os, urllib, sys 
 
# Setup URL - Change for your project site - find by going to your project site 
then Show Map then Google Earth Tab then right click>Copy link address on 
"Click here to view data in Google Earth" link to get the URL for your project.  
Paste that URL in below. 
kmlURL = 
"http://epicollectserver.appspot.com/getMapKML?projectKey=ahBlcGljb2xsZW
N0c2VydmVychALEgdQcm9qZWN0GJ-E3AEM" 
 
# local file name 
kmlFile = "c:/temp/epilitter.kml" 
 
outDir = "C:/temp" 
 
# Get html page and store in a local file 
urllib.urlretrieve(kmlURL, kmlFile) 
 
# Convert to a lyr file and geodatabase 
arcpy.KMLToLayer_conversion(kmlFile, outDir) 
 
print "All Done!" 

 
 
2.  Open Data Kit (ODK) Detailed Instructions 

The ODK website contains good instructions covering the steps needed to setup a 
project using their tools.  Thus I will cover the main points only, referring to the 
website pages that contain detailed instructions. 
 
The Use section of the ODK website covers the three main steps required to build 
your own project:  (http://opendatakit.org/use/)   
 
 
 
 

http://opendatakit.org/use/�
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 ODK calls these three pieces Build, Aggregate, and Collect. 
 1.  Build  - Design a data collection Form 
 2.  Aggregate  - Setup a Server to store the collected data 

3.  Collect  - Download the app from the App Market to the 
Android device then download the form from the server 

 
Collect:  (http://opendatakit.org/use/collect/) 
The Collect step involves downloading the ODK pre-built app from the Google 
App Market then downloading the data collection form built using the Build form 
builder.  The installation and use of the app is straight forward but step by step 
instructions are given on the ODK Collect page if needed. 
 
Build:  (http://opendatakit.org/use/build/) 
The Build step involves creating the form that will be used for data collection.  
The form is built using ODKs web based form builder, which they call Build.  
Note that forms can also be built using other form designers, or built manually.  
The ODK website lists several other form design products that may be used.   
 
The form builder is intuitive and thus exact step by step instructions are not 
covered here.  But one unique feature of the ODK Build that I will cover is the 
ability to construct forms with branches.  For example different sets of fields can 
be shown based on a Yes or No answer to a question.  This allows for 
sophisticated forms to be built that would work well for survey type data 
collection. 
 
Once the form is created it is uploaded to the Aggregate Server by going to File > 
Publish to Aggregate.  The form is then downloaded to the device from within the 
pre-built app obtained from the Google App Market. 
 
Aggregate:  (http://opendatakit.org/use/aggregate/) 
The Aggregate step involves creating an instance of a database type application, 
created by ODK, that uses Google's App Engine.  An instance of the database 
application is created in a users own Google App Engine space and is their own 
application, unlike EpiCollect where the data is stored on their servers.  Google's 
App Engine supplies a complete application dashboard with usage stats, settings, 
and permissions.  Users choose a name to create a URL to their application space 
with the format [appname].appspot.com.  Once the users app space is created, an 
install program is downloaded from ODK to a regular computer (Windows, 
Linux, and Mac are supported) and run.  The program asks for the users app space 
URL along with their Google username and password, then creates a instance of 
the Aggregate server in the users app space.  The process is simple following the 
detailed instructions at the ODK website (http://opendatakit.org/use/aggregate/). 
 
Once the users own ODK Aggregate instance is setup going to the app space URL 
will bring up the Aggregate web based user interface.  This URL is also used in 

http://opendatakit.org/use/collect/�
http://opendatakit.org/use/build/�
http://opendatakit.org/use/aggregate/�
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the ODK pre-built Android App on the mobile device to download the form 
created. 
 
The Aggregate web based interface is small and simple.  There are tools for 
managing the stored user created forms, a list of the data that has been created and 
uploaded to the database using each form, and tools to backup the data to a local 
machine.  The data collected is listed by form.  For each form the data can be 
viewed in the browser as a list, downloaded to a CSV file (which includes all the 
fields, the GPS location, the GPS accuracy at the time the data was collected, and 
a URL to the photo if this was included in the form), downloaded as a KML file, 
or sent to an external service (which includes Google Spreadsheet, Rhiza Insight, 
or Google FusionTables).  All three of these external services can be setup to 
upload all the currently stored data, stream new data as it comes in, or both.  
Using this feature it is possible to map the data for display as it arrives in near live 
time as discussed below.  The CSV or KML file could also be imported into 
ArcMap manually or using a Python script similar to the one shown in the 
EpiCollect section.  (ODK does not yet have a URL to download the KML but 
they are working on adding it.) 
 
App Screen Shots: 
While my plan was to include screen shots of a sample app I created using ODK 
running on a Android tablet, I found out that it is not possible to take screen shots 
on the new Sony Tablet S I used for testing.  In order for screen shot apps to work 
the Android device must be rooted, which is not yet possible on the Sony Tablet.   
 
Displaying Collected Data: 
There are several ways the data collected with ODK can be displayed in a 
computer or mobile device browser.  
 
The simplest method is to download the collected data as a KML file and view it 
in Google Earth or Google Maps.  On a PC the file can be downloaded and 
opened in Google Earth.  On an Android device Google Earth does not allow 
viewing of custom KMLs files so Google Maps must be used.  The KML can 
either be uploaded to My Maps in Google Maps on a PC and then turned on from 
My Maps in Google Maps on the Android device, or the KML can be posted to a 
web server and a link created that the user can click on in the Android device.  
The URL format is http://maps.google.com/?q=[URLtoFile].  On iOS this URL 
can be used with Google Maps in the same way as with an Android device.  On 
iOS Google Earth can also be used by entering a URL to the KML file in the 
search bar (without the http://maps.google.com/?q prefix). 
 
If the data is linked to a Google Fusion table, a user can access the table within 
Google Fusion on a mobile device web browser or a regular computer browser, 
then click Visualize, then Map.  Also a direct link to this map can be found by 
clicking Get link at the top right of the map page, then posted to a web site or 
emailed.  In the Google Fusion map there is also a link to a KML file of the 
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Fusion table data under Get KML network link.  This link can be used with the 
URL prefix format shown above for display in Google Maps.  Note that 
occasionally Google Maps will not load the KML using the Fusion network link.  
If this occurs instead enter the KML network link URL in the Google Maps 
search bar then use the link button in Google Maps to create a URL directly to a 
Google Map that is linked to the Fusion table.  Pushing the collected data to a 
Fusion table and then linking to the table allows for newly collected data to be 
seen as it is published to the server in near live time. 
 
One major limitation to the above methods is that Google Maps has a built in 
limit of 1,000 features for any KML it displays.  This is true on regular computers 
and mobile devices.  Google Earth has no limit, but as mentioned above, the 
Google Earth for Android App can not yet load custom KML files.   
 
Another way to map the data would be to import the KML or CSV file from ODK 
Aggregate into ArcMap, then publish to a ArcGIS Server for use in a ArcGIS 
Server web application or in the Esri mobile apps.  A Python script could be 
created to automate the process or run the process on a schedule.  Scripts could 
also grab the data from Google Fusion tables or Google Spreadsheet if used. 
 
For more detailed information on using KML files see the detailed instructions 
section on KML files. 

 
 
3.  Detailed Instructions for Esri Tools 

Esri has developed mobile device tools for Android, iOS, and the Windows 
Mobile operating systems.  All of the Esri mobile tools require a ArcGIS Server 
for full implementation, with Windows Mobile also requiring ArcMobile.  In 
order to enable editing of features within the mobile tools, or in a Web browser, 
the data layers must be stored in a SQL database system and connected to ArcGIS 
Server with ArcSDE.  Thus detailed instructions on how to install the Esri 
products ArcGIS Server, ArcMobile, and ArcSDE are all covered here.  
Instructions on setting up the two most popular free SQL databases, Microsoft 
SQL Express and PostgreSQL, are also detailed.  With this full set of installation 
instructions a complete system to deploy Esri mobile applications can be created 
from scratch. 
 
The process below is broken into two major components.  The first part details all 
the steps needed to install and configure a ArcGIS Server, a SQL Database, and 
ArcSDE on a Windows Server from scratch.  The first part also details how to 
copy existing GIS data, such as shapefiles, over to a SQL Server and then publish 
a map, created in ArcMap, to a ArcGIS Server.  The second part details the steps 
needed to create mobile applications.  Therefore if a ArcGIS Server is already 
setup and running with a map published to it, skip to the "Creating Mobile 
Projects" section below. 
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Note for this paper ArcGIS Server version 10 on Windows 2008 R2 Datacenter 
was used.  Other configurations will have differences but the overall procedure 
should be similar. 
 
a.  Installing ArcGIS Server, a SQL Server, and ArcSDE 

There are several steps that must be completed in order to setup a fully 
working ArcGIS Server installation that uses data stored in a SQL 
Database.  Since Esri already supplies detailed help files, for this paper 
only the hidden tricks and traps are discussed with references and links to 
Esri help files included for exact click by click directions. 

 
Install ArcGIS Server 

Since Esri provides detailed help files for installing ArcGIS Server 
only special notes, covering potential problem areas, are covered 
here.  Note that the steps below must be done in order.  The full 
ArcGIS Server installation help is available online 
here http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server
_dotnet_help/index.html.  There is also install help as part of the 
installation program.  Note this help will only work in Internet 
Explorer.   
 
Install Microsoft .NET Framework 3.5 Service Pack 1: 
The test servers used for this paper had Windows 2008 R2 
Datacenter therefore I choose to install the ArcGIS Server for the 
.NET Framework.  If using the .NET version you must first install 
Microsoft .NET Framework 3.5 Service Pack 1.  On one test server 
I was able to download and install the file from Microsoft without 
issue, but on the second test server I had to install the .NET 
Framework from within the Windows Server Manager.  To install 
open Server Manager, go to Roles, then Add Roles, then select 
Application Server.  A prompt will ask if .NET 3.5 should be 
added.  Note that installing a newer version of .NET will not work, 
the older 3.5 version must be installed.  For more details on this 
step 
see http://beyondrelational.com/blogs/brumedishetty/archive/2010/
03/18/installing-net-3-5-framework-in-windows-server-2008-
r2.aspx. 
 
Install Microsoft IIS: 
ArcGIS Server requires Microsoft IIS (Internet Information 
Server) to be installed on the same server.  In Windows 2008 IIS is 
installed using the Role Services just as with .NET.  In Windows 
Server Manager open Roles, then click Add Roles.  When the Add 
Roles Wizard appears check Web Server (IIS) and then click next, 
then next again.  In the list of services to install it is very important 
to check the box next to Application Development, Security, and 
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IIS6 Management Compatibility as they are all needed by ArcGIS 
Server.  Click next then install. Note if you missed these options 
the first time right click on Web Server under Roles in Server 
Manager and pick Add Role Services.  Note the exact options 
needed are listed in the ArcGIS Server install help on the CD. 
 
Install ArcGIS Server 10 for the Microsoft .NET Framework:  
Load the ArcGIS Server CD or start ESRI.exe from the directory 
where the install files are located.  The start page lists several 
install options but for this paper the .NET Framework version of 
ArcGIS Server will be used..  If this server will only be using 
ArcGIS Server for mobile applications only GIS Services should 
need to be installed.  If using maps inside of a web browser is 
needed then Web Applications must also be installed.  Installing 
both is suggested. 
 
First install GIS Services by simply clicking on Setup and 
following the prompts, accepting the defaults.  Once the install has 
completed the GIS Server Post Install will start.  The post install 
sets up Windows accounts for the ArcGIS Server services.  The 
process is straight forward but for more information on this step 
see http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server_
dotnet_help/index.html#/Configuring_a_one_machine_deployment
/0093000000m6000000/ 
 
Next install Web Applications by simply clicking on Setup and 
following the prompts, accepting the defaults.   
 

 Add the SOC account to data directory: 
Create a directory where any maps that will be published will 
reside.  Give the SOC account created in the step above full rights 
to this directory.  For more information 
see http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server_
dotnet_help/index.html#/Configuring_a_one_machine_deployment
/0093000000m6000000/ 
 
Add a user account to agsadmin group: 
The Windows user account that will be used to login to the ArcGIS 
Server Manager needs to be added to the agsadmin group if it is 
not already.   
 
Reboot the Server: 
At this point a reboot of the Windows server is a good idea as 
group membership changes and certain IIS changes may require it. 
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Login to ArcGIS Server Manager: 
At this point test to make sure the user account used above can 
login to the ArcGIS Server Manager.  In a web browser on the 
server go to http://[Server IP or Host Name]/arcgis/manager/.  At 
the login screen use the username added to the agsadmin group 
above.  Make sure to proceed the username with the domain name 
or local machine name depending on the location of the account, 
such as winserver\user.   
 
Install Esri Service Packs: 
It is a good idea to install all service packs available for the version 
of ArcGIS Server being used.  Note that you will need to stop the 
two ArcGIS Server Windows services before installing the service 
packs.  Once the service packs are installed restart the ArcGIS 
Windows services.  
 

Install ArcGIS Desktop on the Server 
While not required, installing a copy of ArcGIS Desktop on the 
ArcGIS Server will come in handy.  Having a local copy allows for 
easy checking of map documents and allows for ArcCatalog to be 
used for managing the server if desired.  See the help 
document http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_s
erver_dotnet_help/index.html#/Making_an_administrative_connec
tion_to_ArcGIS_Server_in_ArcCatalog/0093000000n6000000/ for 
more details. 
 

Install a SQL Database Server 
In order to edit features in a mobile app, or in a web browser, the 
GIS data needs to be stored in a SQL database and connected to 
ArcGIS using ArcSDE.  The two most popular free SQL servers 
supported by ArcSDE are Microsoft SQL Express and 
PostgreSQL.  Choose only one of the two database systems below 
as my testing showed that both will not run properly when installed 
on the same system. 
 
Install MS SQL Express: 
For this paper I used Microsoft SQL Express 2008.  Make sure to 
search for and download the version that comes with the tools as 
seen 
here http://www.microsoft.com/download/en/details.aspx?displayl
ang=en&id=22973.  Once downloaded run the install program.  If 
a warning that service pack 1 or above must be installed, quit the 
install, then download and install the latest service pack (at the 
time of this writing service pack 3 was the latest).  Once the 
service pack is installed run the SQL install 
(SQLEXPRWT_x64_ENU.exe) again.  The SQL Server 
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Installation Center will appear.  On the Planning tab run the 
System Configuration Checker to make sure the server is ready.  
Then on the Installation tab select New SQL stand-alone 
installation.  Make sure Management Tools is checked.  On the 
Server Configuration page set the user to \system and Server 
Browser to Automatic.  At the Database Engine Configuration 
page decide if you will use Windows Authentication or Mixed 
Mode.  I used mixed, then added a password and added my current 
Windows user account.  For a full discussion on this see the 
ArcGIS Server help 
here http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server
_dotnet_help/index.html#/What_are_user_accounts/002q00000027
000000/.   After installation is complete TCIP may need to be 
enabled and SQL Server to may need to be added to the firewall 
exceptions.  Once completed stop and restart the service.  See this 
page for more 
details http://www.symantec.com/connect/articles/install-and-
configure-sql-server-2008-express.  Next skip down to the install 
ArcSDE for Microsoft SQL Server section. 
 
Install PostgreSQL: 
For this paper I used PostgreSQL version 8.3 for Windows that 
comes on the ArcSDE install CD, but PostgreSQL may also be 
downloaded and installed separately.  However be aware that 
ArcSDE does not support the latest version of PostgreSQL, which 
is version 9.  PostgreSQL is a free, open source, SQL server 
available for download at http://www.enterprisedb.com/products-
services-training/pgdownload#windows.   
 
If installing from the ArcSDE CD or installation files start esri.exe.  
At the ArcSDE install page click 32-bit Setup next to ArcSDE for 
PostgreSQL and open the install guide if needed.  In setup leave 
both options checked to install both PostgreSQL 8.3.8 and ArcSDE 
for PostgreSQL, then click Install.  The PostgreSQL install 
program will start.  On the Installation Options page the default 
options can be used.  On the Service Configuration page keep the 
defaults but make sure the password given to the service is 
remembered.  On the next page, Initialize database cluster, 
ArcSDE recommends changing the encoding method to UTF-8.  
For more details on this, or if you need to change the port number, 
see the ArcSDE install help on the CD for more details.  Click next 
then next again. On the Enable contrib modules page check 
plDebugger, the click next, then next again to install.  Once the 
PostgreSQL install is complete the ArcSDE install will start.  Note 
the pg_hba.conf file and postgresql.conf files may need to be 
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altered to allow client connections before running the ArcSDE 
install.  See the ArcSDE install help for more information.  
 

Install ArcSDE  
 If using Microsoft SQL Server: 

Insert the ArcSDE CD or start esri.exe from the installation files.  
On the start screen select the 32 or 64 bit version of ArcSDE for 
MS SQL Server.  Once the install completes the ArcSDE Post 
Installation program will start.  For information on selecting a 
DBO or SDE schema see the installation guide that comes with the 
CD (I used DBO).  At the User information screen enter the SQL 
Server Instance name that was used when setting up the SQL 
Server, which by default is SQLEXPRESS, and select Windows or 
SQL Authentication.  The trick here is to include the name of the 
machine as part of the SQL Server instance name in this step and 
all future steps.  Thus the default name is [Computer 
Name]\SQLEXPRESS.  On the next page choose a database name.  
On the last page the service information is entered.  This part was 
tricky for me.  The first trick is that the computer name must be 
included before the database name as discussed above.  If using 
Windows authentication and the dbo scheme, in the SDE username 
box a windows account that has access to the database must be 
used and the username must be proceeded with the domain name 
of the account.  In my case a local account was used so the proper 
input was [Local machine name]\username.  Hopefully at this point 
the SDE service will start.  If an iomgr error appears the database 
name or username is not correct.  For more information on this 
issue see the installation help on the CD. 

 
 If using PostgreSQL: 

If PostgreSQL was installed from the ArcSDE CD the ArcSDE for 
PostgreSQL Setup Program will automatically start.  If 
PostgreSQL was installed separately then start the install from the 
CD, un-checking the Install PostgreSQL option and checking the 
ArcSDE install option.  For this install simply accept the defaults.   
 
Once the install is complete the ArcSDE for PostgreSQL Post 
Installation Setup will start.  Click complete then next.  Enter the 
PostgreSQL username and password created when PostgreSQL 
was installed then click next.  On the SDE user and tablespace 
information page enter a password for the SDE user to use, keep 
the defaults for the rest, then click next (if the defaults are changed 
make sure to track what names are used).  If experienced users 
have configuration files they can be used here, else click next.  At 
the Repository Setup page the fields should fill in automatically, if 
so click next.  After a few seconds hopefully a box will appear 
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saying the ArcSDE Repository was successfully setup.  If not 
recheck the username and passwords entered.  Also make sure 
MSSQL is not installed on the same server as they will not work 
together.  If the setup was successfully click No to skip viewing 
the SDE status.  Next authorize the install with a file or code from 
Esri.  At the ArcSDE service information page it is best to accept 
the defaults, but if any changes are made make sure to note them, 
then click next.  ArcSDE will now attempt to create and start a 
Windows service.  If the service fails to start it is usually a 
username or password error, but can also be caused by past 
installations.  If a ArcSDE install was attempted previously on this 
server try changing the service name from esri_sde to esri_sde2 for 
example.  This may cause a box to appear explaining that there is 
already a service using port 5151.  If so click ok, scroll to the 
bottom of the text document and remove the line assigning a 
service to port 5151.  Save and close the document and try again.  
Once the service successfully starts click finish.   

 
Copy GIS data to the SQL Server 

Once ArcSDE is installed and configured test to see if the SQL 
database can be opened in ArcMap.  Open ArcMap on the server, 
then in the ArcCatalog tab expand Database Connections, then 
double click Add Spatial Database Connection.  In the Server field 
give the name of the computer only (do not include 
\SQLEXPRESS for example).  In the Service field enter the name 
of the ArcSDE Windows service, which by default is esri_sde.  In 
the Database field enter the name of the database you gave when 
setting up the SQL Server.  If MSSQL with dbo was used, in the 
connection detail section click change then select dbo.DEFAULT 
and click ok.  If PostgreSQL was used enter the password under 
the database authentication section and the rest of the fields should 
default properly, but change if needed.  Finally click Test 
Connection and hope it connects.  If the connection succeeds click 
ok.  Note that you may want to use a username different from the 
default sde or setup multiple users depending on your project.  
Finally check to make sure the connection shows in ArcCatalog 
under Database Connections.  For more information see the help 
documents on the ArcSDE CD or the ArcGIS Server help 
here http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server
_dotnet_help/index.html#/Geodatabase_connections_in_ArcGIS_
Desktop/002q00000031000000/. 
 
In ArcMap create a map document and save.  Add the data to be 
moved to the SQL Server to the ArcMap TOC.  In the ArcCatalog 
tab expand Database Connections.  Right click on the connection 
made above and select Import > Feature Class (single), unless you 
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are importing some other type of file.  Select the layer to copy, 
give it a name in the Output Feature Class box, then click OK.  The 
layer should appear under the Connection in ArcCatalog and add to 
the TOC.  The data is now in the SQL Database. 

 
Publish a GIS Resource 

The next step is to publish a map document using the data stored in 
the SQL Database on the ArcGIS Server.  Open ArcMap and 
create a new blank map.  Add the data layer(s) from the SQL 
database using the Add Data button or by dragging them over from 
ArcCatalog under Database Connections.  Setup symbology as 
desired.  Add the Map Service Publishing Toolbar to ArcMap.  On 
the Map Service Publishing Toolbar click the Save Map Service 
Definition button and give it a name.  A Map Service document is 
simply a compressed version of a regular .mxd map document, 
which may also be used. 
 
In a web browser login to ArcGIS Server Manager.  Under 
Services click on Publish GIS Resource, then at the top click 
Publish GIS Resource.  In the Publish a GIS Resource page that 
appears select the .msd created above, or the .mxd, in the Resource 
field.  Note the directory where the map and data are stored, or a 
folder above it, must be shared in Windows before the directory 
can be accessed in this list.  If for some reason an error occurs 
when using a .msd file use the .mxd file instead.  Give the resource 
a Name and choose where to store it (the server root directory or a 
sub directory).  Click Next.  On the capabilities page add a check 
next to Feature Access to allow editing of features.  Note that 
Mobile Data Access may appear here.  This is only for ArcMobile 
and does not need to be checked in order to use the Android or iOS 
apps (and can not be checked if ArcMobile is not installed).  Click 
Next then Finish. 
 
At this point if using MSSQL with Windows Authentication an 
error will probably appear regarding permissions.  This occurs 
because the ArcGIS Server uses a different account then the logged 
in user when connecting.  To correct this, in ArcMap open the 
ArcCatalog tab then expand Database Servers.  Click Add 
Database Server and give the name of the SQL server which by 
default is [computer name]\SQLEXPRESS.  Click ok.  Right click 
the connection created under Database Servers and choose 
Permissions.  Click Add User then add the ArcGIS SOC user that 
was created, which by default is ArcGISSOC.  Highlight the new 
user added and check the Server Administrator box.  Click ok.  
Then go to the ArcGIS Server Manger Manage Service page and 
start the service just created.  It should now start and be available.  
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For more information see this help 
page http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server
_dotnet_help/index.html#//00930000005v000000. 
 
If using PostgreSQL the service should start without any extra 
changes needed. 

 
Create a ArcGIS Server Web Application (if desired) 

A ArcGIS Server Web Application provides a web browser based 
mapping interface for ArcGIS maps.  The Web Application is not 
required for using any of the mobile apps, it is only required if 
using the map published above within a web browser.  The Web 
Application will work within a web browser on a mobile device 
but there are some functional and usability limitations due to the 
small size of mobile devices and their touch based interfaces.  The 
exact limitations are discussed at the beginning of this paper.  For 
most projects a Web Application would only be used within a 
regular computer web browser. 
 
Web Applications are created in the ArcGIS Server Manager.  To 
create a Web Application first publish the GIS resource as detailed 
above.  Then in ArcGIS Server Manager go to Applications > Web 
Applications then click Create Web Application at the top.  Give 
the Web App a name, select what layers will be included on the 
map, add tasks such as query and print, then choose what map 
elements are available.  When completed the map can be used in a 
web browser by going to http://[server name]/[map name given].  
For more information on creating Web Applications see the 
ArcGIS help file 
here http://help.arcgis.com/en/arcgisserver/10.0/help/arcgis_server
_dotnet_help/index.html#/Introduction_to_creating_Web_applicati
ons_with_Manager/009300000083000000/. 

 
b.  Creating Mobile Projects 

At this point it is finally time to create the Mobile Projects.  There are 
major differences between how the Android and iOS Esri apps work 
versus how Windows Mobile projects are created.  Also it is important to 
note that ArcMobile is for Windows and Windows Mobile apps only.  It is 
not required for using the Android or iOS apps at all.  Esri calls the 
Android and iOS apps Esri solutions for Smartphones, while the Windows 
apps are called Esri for Mobile. 
 
The Android and iOS apps available in the App Market/Store are built by 
Esri.  The Apps provide the structure, or container, around maps that are 
loaded from the internet.  The user simply chooses what maps they want to 
view.  The mobile project creator only determines what layers will appear 
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on the map within the Esri built app, they do not build a separate app.  The 
Esri app always stays the same, the content viewed in the map is all that 
changes.  The mobile map project can be stored and loaded from ArcGIS 
Online or a ArcGIS Server.  In other words the Esri apps work like a web 
browser.  What is displayed inside the browser is set by the page creator 
and loaded from the internet but the browser itself is not controlled by 
page creator.  Also like a web browser the mobile device must be 
connected to the internet in order to view maps.  There are no offline 
mapping or data collection capabilities.  There is talk of Esri adding 
offline capabilities in 2012 but no formal dates have been set.  The major 
differences between the Esri Mobile Apps and viewing maps in a web 
browser is the mobile friendly interface of the apps and integration with 
the mobile device's GPS. 
 
With Windows Mobile projects are loaded in to a base app then compiled 
into a .wmpk file.  The Projects are created using the ArcMobile Mobile 
Project Center and then copied to the device manually or the project files 
can be downloaded from a ArcGIS Server to the device.  Once the project 
files are loaded on the device internet connectivity is no longer required.  
A cached local copy of the map is used instead of loading from the 
internet and offline data collection is supported (with the ability to sync 
updates to a server when connected).  When building a Windows Project 
there is control over the maps displayed as with the smartphone apps, but 
with ArcMobile there is also control over what tasks are available, such as 
Collect Features, Search, Work List, and Manage Edits.  ArcMobile 
Projects provide a mobile friendly interface and integration with the 
mobile device GPS. 
 
i.  Android and iOS Apps 

The first step in creating a map project for the Android and iOS 
apps is to publish a ArcMap .msd or .mxd file on the ArcGIS 
Server.  This is done using Publish a GIS Resource in the ArcGIS 
Server Manger as described above.  Once the GIS Resource is 
published there two options to create a map project, either author 
and publish a map using ArcGIS online or add a map to the Mobile 
Content Server section of ArcGIS Server.  
See http://resources.arcgis.com/node/4559 for more.  (Again note 
that even though this is called Mobile Content Server it is part of a 
default ArcGIS Server install and does not require ArcMobile to be 
installed.)   
 
Install the Esri smartphone apps: 
Before creating custom maps for the Esri smartphone apps (for 
Android and iOS) the appropriate pre-built app needs to be 
installed on the mobile device.  To install the Android App, on the 
Android device tap Apps then tap Market.  In the App Market 
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search for Esri and install the ArcGIS App by Esri.  On iOS 
devices open the App Store, search for Esri and install the ArcGIS 
App from Esri.  Once installed open the App and test it by tapping 
on Gallery and viewing some maps published by others.  The next 
section covers how to publish custom maps. 
 
How to use ArcGIS Server REST URLs: 
Before discussing how to create a map project for use on a Mobile 
device, how URLs to published resources on a ArcGIS Server 
work needs to be understood.  Each map resource published to a 
ArcGIS Server is given a URL to a read only copy of the map and, 
if feature access was enabled, a URL to an editable copy of the 
map.  These URLs use the REST protocol.  The easiest way to find 
the URLs to each map is to go to the ArcGIS Services Directory 
found at http://[server ip or domain name]/ArcGIS/rest/services.  
On this page all of the published GIS resources will be listed.  The 
read only map links are called MapServer and the editable map 
links are called FeatureServer.  The REST URL to the resource is 
found by hovering the mouse over each link, copied to the 
clipboard with a right click copy link address, or by clicking on the 
link and brining up the webpage about that service.  The format 
will be  
http://[sever ip or domain name]/ArcGIS/rest/services/[Resource 
name]/MapServer (or FeatureServer for the editable layers if 
enabled).  Clicking on the link to the MapServer document brings 
up the page about the published resource and contains links for 
opening the resource in many different ways.  This page also lists 
the layers included in the map and the URLs to the individual 
layers.  URLs to layers have the format of http://[ sever ip or 
domain name]/ArcGIS/rest/services/[Resource name 
]/MapServer/0 with the last / number being different for each map 
layer.  Now that the URLs to published data on a ArcGIS Server 
are understood, these links are used to build a map project for 
mobile devices.  For more details on REST with ArcGIS Server 
see http://help.arcgis.com/en/arcgisserver/10.0/apis/rest/. 
 
Using ArcGIS Online: 
To create a map using the free service called ArcGIS Online from 
Esri, go to ArcGIS.com, login using a Esri Global Account, then 
click My Content.  The mobile map project is built by adding 
online basemaps and maps or layers from a ArcGIS Server.  To 
start click Create Map to start a new blank map.  To add basemap 
layers simply click basemap and choose the basemap desired.  
Maps or layers from a ArcGIS Server can be added in several 
different ways.   
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If unsure about the exact URLs to the ArcGIS Server resources 
click Add > Search for Layers.  Change the In box to "A GIS 
server" then in the URL box enter the IP or domain name to the 
ArcGIS Server plus /arcgis at the end and click enter.  All of the 
published resources on the ArcGIS Server should be listed.  The 
read only Map links will have just the name of the resource while 
the links to the editable maps will have "(Feature Service)" after 
the resource name.  Click Add next to the layer and type desired 
(read only or editable) to add it to the map.  When finished click 
Done Adding Layers at the bottom.   
 
If the URLs to each resource are known go to Add > Add Layer 
from the Web, select ArcGIS Server Web Service, then enter the 
URL to the service to add.  A URL to a MapServer, a 
FeatureServer, or to a layer can be used (for example http://[ sever 
ip or domain name]/ArcGIS/rest/services/[Resource name 
]/MapServer or /FeatureServer or /MapServer/0).  Once all the data 
is added the map can be customized in a number of other ways - 
see the ArcGIS Online help for more details.  Once the map is set 
as desired, click Save and name the map.  For more on using 
ArcGIS Online see the help 
here http://help.arcgis.com/en/arcgisonline/help/index.html#/Openi
ng_content/010q0000000v000000/. 
 
Once the ArcGIS Online map is built and saved it can be accessed 
on the mobile device.  The Esri Android and iOS apps look almost 
identical so the steps listed here will be the same on either type of 
device.  First open the app by tapping it.  At the start screen login 
to the Esri Global Account used by tapping the padlock icon in the 
upper right and entering the user name and password.  One logged 
in the My Maps button becomes available.  Tap the My Maps icon 
then tap the Map created above at ArcGIS Online, then tap View 
Map.  The map created above should appear.  For more on using 
the apps see below. 
 
Using the Mobile Content Server on a ArcGIS Server: 
The other way to create a map project for use in the Esri 
smartphone apps is by using the Mobile Content Server on a 
private ArcGIS Server.  To open the Mobile Content Server enter 
the URL http://[server ip or domain name]/ArcGIS/mobile/content 
in a web browser.  Click on MobileWeb then the Maps folder 
(which is the default folder).  To create a new Mobile Map click 
Add Item.  This next part can be tricky to understand and may 
require some trail and error, especially if security is desired.  
Documentation on the next steps is sparse with the only document 
I could find being a short PDF 
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here http://help.arcgis.com/en/arcgismobile/10.0/apis/iphone/AppG
uide/Maps.pdf.   
 
The Item page that appears is where the mobile map project is 
created.  The Text field contains the layers to be included in the 
map, listed using the JSON format.  The best way to construct this 
field is to start with the sample given in the above PDF and then 
change the URLs to the maps desired.  Be careful, as at the time of 
this paper the sample had a small error in it.  Because of this 
included here is the JSON I used.  This sample map project 
contains a read only map from my ArcGIS Server and a world topo 
basemap from Esri.  More maps can be added by adding more in 
the opeationalLayers section. 
{ 
"version":"1.1", 
"operationalLayers":[ 
{ 
"url":"http://152.7.99.51/ArcGIS/rest/services/BunOnly/MapServe
r", 
"visibility":true, 
"opacity":1, 
"title":"Bun Map" 
}], 
"baseMap":{ 
"baseMapLayers":[ 
{ 
"url":"http://services.arcgisonline.com/ArcGIS/rest/services/World
_Topo_Map/MapServer" 
} 
], 
"title":"Topography" 
} 
} 

 
In the item field give the map a unique identifier, then give the 
map a Name, Title, Description, and Snippet.  The Extent field is 
used to give the map an initial extent when opened.  The format is 
xMin, yMin, xMax, yMax (no parenthesis) where the x and y are 
in GCS coordinates.  Hint: the easiest way to find the GCS 
coordinates is to open the map in ArcMap, right click the data 
frame (called Layers by default), then on the General tab under 
Units set the Display units to Decimal Degrees and click ok.  Then 
use the mouse to hover over near the top, bottom, left, and right 
edges to find the map extent.  Leave the rest of the fields as default 
and click Add Item.  A page will display letting you know if the 
map was created successfully with a simple "Success: true" or 
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"Success: false".  If false delete the item and start again.  Note that 
for some unknown reason there is no way to edit a map item once 
created so make sure to save the JSON code in Notepad before 
clicking Add Item in case the load fails and the item document 
needs to be created again. 
 
Just as with ArcGIS Online, different URLs can be used to load 
read only (/MapServer) or editable maps (/FeatureServer).  Plus 
/[layer number] can be added to the URLs to load just one layer 
inside the map instead of the whole map.  When using 
/FeatureServer the example code in the PDF file includes a mode 
line in the JSON code but I could find no documentation on what 
this does. 
 
Since there is almost no documentation on building the JSON map 
code I did a lot of testing.  I found that /MapServer was much 
faster than /FeatureServer and that /FeatureServer often failed to 
load all the way.  I was unable to determine exactly how these 
JSON blocks should be constructed so it is left to the user to test 
and create a map that works for their project. 

 
 Notes on using the Apps: 

For this paper I tested the Android and iOS apps extensively.  I 
found the iOS app to be more polished in terms of look and 
operation.  The buttons and legend looked much better in the iOS 
app.  Tapping to see attributes of features worked in iOS well, but 
never worked in Android.  Editing of features worked well in iOS 
but in the Android App the edit button would not appear at all 
many times, would often given errors, and would never allow me 
to change the attributes of existing features, only create new ones.  
These differences are probably due to the fact that the iOS is in 
version 2.1 while the Android app is in version 1.0 and was just 
released as I was compiling this paper.  This should change as both 
apps are currently being actively updated, with plans for majors 
enhancements, such as offline use, to be implemented in 2012. 

 
ii.  Windows Mobile Apps (version 5 to 6.5) 

In order to develop Windows Mobile projects ArcMobile must be 
installed.  ArcMobile installs two programs, one called Mobile 
Project Center for building the apps, and ArcGIS Mobile which 
works as a Windows Mobile emulator for testing the apps.  Note 
that you may also see ArcMobile called ArcGIS for Windows 
Mobile or ArcGIS Mobile.  Also note that this section applies to 
Windows Mobile devices from version 5 to 6.5 only.  Microsoft 
has renamed what would be Windows Mobile 7 to Windows Phone 
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7.  The process used to built projects for Windows Phone 7 is 
completely different (see below for details). 
 
The first step is to install ArcMobile.  After inserting the CD, or 
running esri.exe, the ArcGIS Mobile install start page appears.  
The page separates the process into ArcGIS Mobile, which installs 
the Mobile Project Center, and ArcGIS Mobile Windows 
Application, which installs the Windows Mobile emulator.  
However, note that the ArcGIS Mobile Windows Application is 
installed by default when installing ArcGIS Mobile so there is no 
need to run both installs.  There are install instructions available 
from this start page, but these only cover the main install portion.  
Note that before installing ArcMobile any ArcGIS services that are 
running, such as ArcGIS Server and ArcSDE, must be stopped.   
 
For the main install simply accept the defaults.  Once ArcGIS 
Mobile is installed instructions on building a Windows App are 
available from the start menu at All Programs > ArcGIS > ArcGIS 
Mobile > ArcGIS Mobile Help or from the web 
at http://help.arcgis.com/en/arcgismobile/10.0/help/index.html.  
Make sure to restart any stopped ArcGIS services once ArcMobile 
is installed. 
 
The next step is to build a project within the Mobile Project 
Center.  Start by opening Mobile Project Center then click New.  A 
new blank Mobile Project is created.  First add the operational 
layers and basemap layers desired.  Operational layers can be 
added from a ArcGIS Server or a local Mobile Cache.  However, 
before layers from a ArcGIS Server can be added they must be 
enabled for mobile access.  To enable mobile access, on the server 
where ArcGIS Mobile was installed login to the ArcGIS Server 
Manager.  Under Services > Manage Services find the GIS 
Resource that has already been published, or publish a new GIS 
Service (see above for instructions on how to publish).  For an 
already published resource click edit.  On the Capabilities tab 
enable Mobile Data Access with the checkbox and click Save and 
Restart.  Once enabled add the layers desired to the project. 
 
Once the map layers are added the Tasks must be configured.  In 
the Mobile Project Center click Tasks at the bottom left.  Next 
click Add and chose a Task, which include View Map, Collect 
Features, Search, View Work List and Manage Edits.  Make sure 
to check the options for each task.  Note that for editing to work 
the data for the maps must be stored in a SQL database as 
discussed above.  Finally there is an option to add capabilities 
which include Field Crew Logging and the ability to Sign In.  

http://help.arcgis.com/en/arcgismobile/10.0/help/index.html�
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Once the maps, tasks, and capabilities are configured as desired 
click Save to save the Mobile Project to the local computer, to a 
ArcGIS Server, or to ArcGIS.com.   
 
Once the Mobile Project has been saved open the ArcGIS Mobile 
application which works as a Windows Mobile emulator.  Click 
Download Project, select the location the project was saved to, 
then click List Projects, then click the project created to download.  
You may be asked to download the data layers also.  Once 
downloaded the Mobile Project created above will appear.  The 
ArcGIS Mobile emulator allows you to use the app just as it would 
appear on a Windows Mobile device, except of course the GPS 
integration will not work.  If using a true Windows Mobile device 
the .wmpk project file can be distributed to the devices in several 
ways.  Since I was unable to obtain a Windows Mobile device for 
testing the exact steps required to deploy ArcMobile apps is not 
covered in this paper.  Instead see the help 
at http://help.arcgis.com/en/arcgismobile/10.0/help/index.html#/De
ploying_mobile_projects/007v00000019000000/ for more 
information. 
 

iii.  Windows Phone 7 Apps 
For the most recent release of Windows Mobile Microsoft renamed 
the product Windows Phone 7.  With Windows Phone 7 Esri has 
developed a app similar to the Android and iOS apps where a base 
app built by Esri is downloaded, then REST is used to display web 
based maps.  Since I was unable to obtain a Windows 7 phone I 
was unable to test this app for this paper. 

 
 
4.  Using KML Files Detailed Instructions 

Several of the data collection and display solutions discussed in this paper use 
KML files in some capacity.  Thus I did a lot of experimenting with KML files, 
specifically how they work with Google Earth and Google Maps. 
 
While testing KML files for this project several inconsistencies were found in 
how KML files display depending on how they were created and in what program 
they are displayed.  Since I was unable to determine the exact cause of the 
inconsistencies discovered, exact detailed instructions on how to create and use 
KML files is not covered here.  Instead general techniques are discussed along 
with the inconsistencies that arose.  Any workarounds developed for the issues 
discovered are detailed as are any limitations. 
 
a.  Google Earth 

Google Earth is a common way to view KML files.  To view a created 
KML file on a regular computer the KML file is simply downloaded to the 

http://help.arcgis.com/en/arcgismobile/10.0/help/index.html#/Deploying_mobile_projects/007v00000019000000/�
http://help.arcgis.com/en/arcgismobile/10.0/help/index.html#/Deploying_mobile_projects/007v00000019000000/�
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local machine and then opened in Google Earth with a double click on the 
file or with a File > Open in Earth.  Points, polygons, and images can all 
be represented and stored in KML files along with full attribute tables.  
The iOS Mobile App for Google Earth can also display created KML files 
by first loading the KML into My Maps through Google Maps then 
opening My Maps within the iOS Earth App.  At this time the Android 
App for Google Earth can not display custom KML files. 
 

b.  Google Maps 
While it is used less frequently, KML files can also be displayed as a layer 
in Google Maps.  There are two main ways to display a KML file within a 
Google Map.  The first is to import the KML into "My Places" in Google 
Maps after signing into a Google account.  Once Imported the KML can 
be turned on and off as a layer in Google Maps anytime the user are 
logged in.   
 
The second way is to post the KML to a website then create a Google 
Maps URL that points to this file.  The format of the URL is 
http://maps.google.com/?q=[URL to KML].  If a website is not available 
the KML file can be stored in Google Fusion Tables.  Once stored in a 
Fusion Table the Fusion Tables mapping interface can be used or the 
direct access URL to a KML version of the stored table supplied by 
Google Fusion Tables can be used to build a Google Maps URL using the 
format above.  Occasionally this method produced an error in Google 
Maps.  The workaround I found was to instead put the URL to the KML 
stored in Fusion in the Google Maps search bar, click the magnifying 
glass, then when the KML loads use the link button that is part of Google 
Maps to produce a link to a map with the KML loaded.  This method also 
has the advantage of being able to set the initial extent as desired, set the 
view type desired, and set the built-in Maps layers to display when the 
Maps is opened.  In my testing both methods worked on a PC, on iOS, and 
on Android.   
 

c.  Inconsistencies 
While testing several KML files I found some inconsistencies between 
how KML files work in Google Earth versus Google Maps and how they 
work on a PC versus on a mobile device.   
 
For this paper I tested KML files created in several ways including: 
exporting a KML from ODK Aggregate; exporting a KML from 
EpiCollect; creating a KML from a shapefile using the ArcMap KML 
tools in toolbox; and creating a KML from a shapefile using the Export to 
KML toolbar add-in developed by the City of Portland (link to tool is 
below).  Each one of these methods created KML files that displayed 
slightly different.   
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The ODK (Open Development Kit) made KML uses the Extended Data 
tag to show the data collected, along with the image collected, in the mini 
popup window that appears when clicking on a point in Google Earth as 
seen here. 
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Unfortunately this nice looking popup does not work in Google Maps on a 
regular computer, instead displaying a popup as seen here. 
 

 
 
 
In the Google Maps mobile apps no popup displayed at all. 
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The EpiCollect made KML also produced nice popup windows in Google 
Earth on a regular computer as seen here.  However notice that the image 
is rotated incorrectly. 
 

 
 



 45 

The EpiCollect KML pop up window also worked in Google Maps on a 
regular computer as seen here.  
 

 
 
 
In the Google Maps mobile app a popup would appear when using the 
EpiCollect KML, but the photo did not display, showing instead the 
outline of the image with a "?" inside.   
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The ArcMap Toolbox made KML file does a nice job of formatting the 
attribute table as seen here, but I was unable to find a way to display 
photos in the popup (though I did find hints that it may be possible using 
the attachment feature).  One workaround found is to make the field 
containing the URL to the image a HTML Popup field in ArcMap, which 
creates a clickable link inside the attribute list to the photo. 
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The attribute table popup looked the same in Google Maps as seen here. 
 

 
 
The ArcMap Toolbox created KML file also worked perfectly in the 
Google Maps mobile apps showing the full attribute able when a point was 
tapped. 
 
The major disadvantage to using the ArcMap Toolbox tool is that lack of 
control over the fields displayed.  There are no options in the KML 
Toolbox tool at all, the tool simply converts a layer or entire map as is.  
One workaround is to create a layer with just the fields desired in ArcMap 
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before exporting.  This tool also does not have options to set the KML 
description field, snippet filed, or name field, but again a layer could be 
created in a certain way as a workaround.   One big advantage to this 
method is that entire ArcMap maps can be converted to KML at once. 
 
The Export to KML toolbar add-in allows for extensive customization of 
the created KML.  In the tool the KML file description, snippet, name, 
layer attributes, time, 3D options, database schema, and other options can 
all be set.  Unfortunately this tool has no way to set the Extended Data tag 
so I was unable to display an image in the popup.  I talked with the 
developer about this but was unable to find a solution.  When creating the 
KML attribute table in the tool the use of HTML is allowed, which may 
provide a solution.  The default attribute table created looks bland 
compared to the one created with the ArcMap Toolbox as seen below, but 
again this can be customized using HTML. 
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The KML created with the Export to KML add-in tool only works 
properly in Google Earth however.  In Google Maps the attribute table 
will not appear as seen here. 
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This is due to the difference in how Google Maps and Google Earth 
handle KML files.  To correct this the "Create Google Maps compatible 
layer" option must be checked within the tool.  The KML files created 
with this option checked still work in Google Earth, as seen below, but 
some options in the tool become unavailable.  This difference in how the 
KML files are handled in Google Earth versus Google Maps becomes 
more of an issue when working with polygons and polylines as discussed 
later in this section. 
 

 
 
The KML file created with the Google Maps option checked also worked 
within the mobile apps but it did not without the option checked. 
 
When creating KML files containing polygons or polylines how the KML 
is created also affects how the KML displays.  Polygons created with the 
Export to KML toolbar add-in can be clicked on in Google Earth to show 
their attribute table but the KML will not load at all in Google Maps.  If 
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the Google Maps compatible layer option is checked, the polygons show 
as points instead of polygons in a Google Map.  Polygons created using 
the ArcMap Toolbox KML conversion tool will show the attribute table 
when clicked in both Google Earth and Google Maps.  The polygons can 
be displayed as either solid objects or outlines with any color settings set 
in ArcMap preserved.     
 
Unfortunately when KML files containing polygons are used in the 
Google Maps mobile app the attribute table will not appear when the 
polygon is tapped on.  After much testing the only workaround found was 
to make a KML that contained both the polygons and points made from 
the polygon centroids.  This allows for the polygons to be seen and the 
points to be tapped to display the attributes. 
 
These differences in how KML files work in Google Earth versus Google 
Maps, and the differences in how they work on a PC versus a mobile 
device will lead to frustration when trying to make a KML file that will 
work, and look, the same everywhere.  This was a disappointment as KML 
files are free, a common format in many programs, and can be used to 
create powerful solutions on a mobile device. 
 

d.  Advantages 
The reason so much time was spent testing KML files was because of the 
power of Google Maps on a mobile device.  Google Maps has full 
integration with the mobile device built-in GPS allowing full turn by turn 
directions to be given as the device moves in live time.  A small add-on 
app even allows for directions to be spoken by a voice through the 
speakers.  Any features added in a custom KML file can also take 
advantage of this routing.  This integration allows a user to select a custom 
feature on the map, then tap directions to receive voice guided directions 
directly to it.  The other powerful advantage of using Google Maps is 
access to all of the built-in locations such as restaurants.  Having access to 
all of the built-in layers allows a user to view landmarks near their current 
location, near a custom loaded feature, or get directions between a built-in 
feature and a custom loaded feature.  It also allows the user to view 
satellite imagery and street views.  This integration would work great for a 
trouble ticket application for example.  A user could view trouble tickets 
on the map near their current location and with a few taps have directions 
to a ticket spoken to them.  The user could even find a place to eat lunch 
nearby with a few taps. 
 

e.  Limitations 
The major limitation with KML files is the 1,000 feature limit Google 
Maps imposes.  This could be a major issue in larger projects.  
Workarounds such as breaking the KML files up by area, or by day, may 
alleviate this issue for some applications. 
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f.  Resources 

The City of Portland Export to KML tool is free from the ArcGIS resource 
center. 
http://resources.arcgis.com/gallery/file/geoprocessing/details?entryID=B4
9A0775-1422-2418-34E1-EEA6DD9851BA 

 
 
5.  Using Eclipse to build Android Apps 

There are several items that need to be downloaded, installed, and configured in 
order to write and compile an Android app.  Having never developed a Android 
app, or even a Java application, before I found the process complicated.  Since I 
was never able to find a complete set of instructions covering all of the steps 
required I believed it valuable to detail them here.  The steps below were tested on 
a Windows 7 machine and must be done in the order listed. 
 
Install a Java Compiler  
 The compiler must be version 1.6, which is called JDK 6. 
 http://www.oracle.com/technetwork/java/javase/downloads/index.html 

Android apps will only compile with a version 1.5 or 1.6 Java compiler.  
Use the link above to download the full JDK (Java Development Kit), the 
JRE only download will not work.  Note JDK 7 is the latest version but it 
will not work for Android apps.  JDK 5 is no longer listed for download so 
JDK 6 is the only option.  Note that you may need to reboot after install so 
the paths to the Java compiler are set up properly.  If you still receive 
errors in later steps, add the directory to the Java compiler to the Windows 
Path environment variable. 
 

Install Eclipse 
 http://www.eclipse.org/downloads/ 

Eclipse Classic 3.7.1 is sufficient for building Android apps.  There is no 
install program, simply unzip the file and run eclipse.exe to use.  If any of 
the other extensive libraries will be required for a project download the 
IDE for Java EE Developers edition.   
 

Install the Android SDK 
 http://developer.android.com/sdk/installing.html 

First download and install the Windows version of the SDK.  At the end of 
the install allow the Android SDK Manager to start.  Check all of the 
boxes listed then click Install Packages.  Note you may not need all of the 
older Android versions listed but make sure to check the Extras box (and 
2.1 is a good idea).  Uncheck samples for each version to make the install 
faster.  After installation of the SDK it may be required to set the path to it 
in Eclipse > Preferences > Android. 
 

 

http://resources.arcgis.com/gallery/file/geoprocessing/details?entryID=B49A0775-1422-2418-34E1-EEA6DD9851BA�
http://resources.arcgis.com/gallery/file/geoprocessing/details?entryID=B49A0775-1422-2418-34E1-EEA6DD9851BA�
http://www.oracle.com/technetwork/java/javase/downloads/index.html�
http://www.eclipse.org/downloads/�
http://developer.android.com/sdk/installing.html�
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Install the ADT Plugin 
 http://developer.android.com/sdk/eclipse-adt.html#installing 

The ADT plugin is installed within Eclipse using the instructions listed on 
the above web page.  Make sure to follow all of the instructions on this 
page, including the Configuration steps, to insure the path to the SDK is 
set properly.  Note that in later versions a dialog box may appear 
automatically after the install completes to assist in this step. 
 

Set Java Compiler to 1.6 if needed 
If another Java compiler has been installed in the past the compiler used 
by Eclipse may need to be changed.  To change, in Eclipse go to Window 
> Preferences > Java > Compiler, and set the compiler version to use to 
1.6. 

 
Installing the ArcGIS API 

The ArcGIS API is installed as a Eclipse plugin just as the ADT plugin 
above.  Instructions are available from the ArcGIS Android Beta program 
website 
at https://betacommunity.esri.com/project/version/default.html?cap=C398
100DFD1A4C9BA638ADDFC688E58F&arttypeid={B296E077-B257-
46D0-B33E-44AA256C79E8}.  Note this is a link into the private 
Android Beta program website.  You must become part of the beta 
program, then login to the site.  Follow the software download link on the 
side bar to the PDF file detailing the steps required. 
 
If you can not obtain access to the beta program site the plugin is installed 
in the same way as the ADT plugin.  In Eclipse go to Help > Install New 
Software > Add.  Then set the name to ArcGIS Android and the URL to 
http://downloads.esri.com/software/arcgis/android.  Check all, then click 
install.  Also note that the API should be out of beta soon so the above 
links to the plugin or the instructions may change. 

 
Create a Android Virtual Device 

Before apps can be tested in an emulator a default emulator needs to be 
created.  First open  the Android ADK Manager.  After it checks for 
updates, which should be installed if there are any, go to Tools > Manage 
AVDs.  Click New.  Name it Android2.1 and select target as Android 2.1, 
or setup another version if desired but note that the newer versions were 
not as reliable for me.  Leave the default settings and click Create AVD.  
Multiple versions can be created and used but Eclipse seems to default 2.1.  
This can be changed for each program.  To change in Eclipse right click 
on the program, go to Run As > Run Configurations, click the Target Tab 
on the right and select the AVD (Android Virtual Device) to use. 

 
 
 

http://developer.android.com/sdk/eclipse-adt.html#installing�
https://betacommunity.esri.com/project/version/default.html?cap=C398100DFD1A4C9BA638ADDFC688E58F&arttypeid=%7bB296E077-B257-46D0-B33E-44AA256C79E8%7d�
https://betacommunity.esri.com/project/version/default.html?cap=C398100DFD1A4C9BA638ADDFC688E58F&arttypeid=%7bB296E077-B257-46D0-B33E-44AA256C79E8%7d�
https://betacommunity.esri.com/project/version/default.html?cap=C398100DFD1A4C9BA638ADDFC688E58F&arttypeid=%7bB296E077-B257-46D0-B33E-44AA256C79E8%7d�
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Compile a sample App  
The best way to confirm all items are installed and working correctly, is to 
compile one of the sample apps that come with the Esri Android API. 

 In Eclipse  
  Click File > New > Project  
   In the Wizard find ArcGIS for Android 

Expand and Select ArcGIS Samples for Android then Click 
Next 
Expand Map_View then Select Hello World then Click 
Finish 

  Click Project > Clean  
   Clean All 
  May need this step 

In Package Explorer Right Click the Hello World project > 
Android Tools > Fix Project Properties 

Run the Project in the emulator 
In Package Explorer Right Click the Hello World project > 
Run As > Android Application.  The emulator will load (be 
patient as it is slow) displaying a Android Phone home 
screen.  Slide the bar to unlock, if necessary, then wait for 
the Hello World application to load. 
 

Success? 
Once the Hello World app fully loads a basemap should appear showing 
the LA area in the emulator.  If you receive any errors see the Common 
Issues section below for fixes. 

 
 To test the app on a real Android device: 

Go to the Eclipse workspace which by default is C:\Users\[User 
Name]\workspace.  In the HelloWorld project directory go to the bin 
folder to find HelloWorld.apk.  This is the compiled application file.  This 
.apk file can be installed on a real Android device by copying it over via 
USB, emailing the file to yourself then opening it on the device, or by 
posting the file to a website then clicking on the file on the Android 
device.  The file will install like any other app then be available for use. 

 
To display other maps in the sample Hello World App 

In Eclipse on the left side find the Package Explorer window.  Expand the 
HelloWorld project, expand res, expand layout, then double click on 
main.xml.  When it appears in the center window click main.xml at the 
bottom center.  In main.xml find the URL showing which map the app 
will open.  This URL can be changed, along with the extent, to a different 
basemap or a map hosted on a ArcGIS Server.  To determine the URL for 
a ArcGIS Server hosted map go to http://[myserver.com or 
IP]/ArcGIS/rest/services, then click on the hosted map desired, then the 
URL to the map will be listed in the browser address bar.  Individual 
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layers within the map can also be used.  The URL to individual layers are 
seen by hovering the mouse over the layers listed or copied by right 
clicking on the layer and name and choosing Copy Link Address.  For 
more information see the help document -
  http://help.arcgis.com/en/arcgismobile/10.0/apis/iphone/AppGuide/Maps.
pdf or view the discussion on the Esri pre-built mobile apps above. 

 
Common Issues 
 Java Heap Space Error 

You will probably receive a Java Heap Space error on the Run As 
> Android App step.  To fix this Edit the eclipse.ini file to increase 
the amount of heap space that is available to Eclipse. The 
eclipse.ini file is found in the same folder as the Eclipse 
executable. This text file contains an entry such as -Xmx384m or -
Xmx256m that controls the amount of memory to reserve for 
running programs.  The forum post I found with the fix said to 
increase this to 512 but I had to increase the size to 1024 (making 
the new line -Xmx1024m) . 
 

No Virtual Device set 
If a AVD was never created before running the first app one must 
be created.  A dialog box should appear asking for a AVD to be 
created.  Follow the "Create a Virtual Android Device" instructions 
above to create a new AVD.   
 

 For 'crunch' errors  
This error should be avoided if all packages were installed during 
the Install Android SDK step above.  If the error still appears 
install the ADK extras. 
 

 To Install Android SDK Extras 
   In Eclipse go to Window -> SDK Manager  
   Check ’repository’, uncheck "installed" 

Wait for all packages to load, then select all support 
packages, accept all, the click install 

   Restart Eclipse 
 

 
 

http://help.arcgis.com/en/arcgismobile/10.0/apis/iphone/AppGuide/Maps.pdf�
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